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Module 4B:
Creating Sheet Metal Parts Enclosing
The 3D Space of Right and Oblique Pyramids
With The Work Surface of Derived Parts

In Module 4B, we will learn how to create sheet metal parts enclosing right and
oblique pyramids, using the Work Surface of Derived Part 3D solid models of right and
oblique pyramid (regular or truncated), which have been created in Module 4A. These
sheet metal parts shall be created with the Face tool, an Inventor tool from the Sheet
Metal panel, which is specially created for sheet metal design, in another sheet metal file.

Like the development of a cone, the flat pattern of a right-axis pyramid (either
regular, frustum or truncated), falls into the category of “radial-line” development, since
all element lines “radiate” out of its central point called the vertex. On the other hand, the
development of an oblique-axis pyramid is generally considered as a development by
triangulation.
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The creation of folded model and flat pattern of sheet metal parts wrapping the 3D space
of pyramids can also be completed by using Inventor’s generic 3D modeling tools such as
Loft, Shell, as shown in Figure 4B-1. However, in this Module, the special Sheet Metal
panel tool of Face with or without Bend option will be explored.

Section 1:
Creating A Sheet Metal Part Enclosing The 3D Space of A Regular Right-
Axis Triangle-Based Pyramid

Step 1: Creating the 1% and 2" Face features with projected sketch profiles

Launch Inventor, start a new Sheet Metal (in).ipt file under the English tab.
Click the Return button to dismiss the default sketch; select the default Sketchl feature
in the Model panel and delete it with the Delete key on the keyboard. Go to the
View-> Isometric menu for better visualization in 3D space. Click-select the Derived
Component tool in the Features panel; the Open dialog window appears; select the Tut-
Right Triangular-Base Pyramid.ipt file inside the Tut-Pyramid folder; and click the Open
button (Figure 4B-2A); the Derived Part tool dialog window opens, and the 3D model of
the Tut-Right Triangular-Base Pyramid.ipt file appears on the screen; click-select the
Body as Work Surface option; the 3D body turns light orange; click the OK button
(Figure 4B-2B); the Derived Part Work Surface model is created in the file as a
reference; and its feature symbol with the name of the reference file is listed in the Model
panel (Figure 4B-61). Save the file as Tut-Right Triangular-Base Pyramid Sheet Metal.ipt
in the same Tut-Piramid folder. Save often throughout the entire project.
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Next, click-select the first lateral surface of the pyramid (Figure 4B-2C); click the
Sketch button to start a new sketch; rename the new sketch “Surface 1 Profile” in the
Model panel; use the Project Geometry tool to project all edge lines of the first lateral
surface onto the Surface 1 Profile sketch (Figure 4B-2D); go to the Command Bar to
change the Style of all projected lines to Normal (Figure 4B-2E); in addition, to prevent
problems of “open loop” when edge lines are projected onto a sketch, use the Circle
Center Point tool to draw a large circle, use the Extend tool to extend all projected edge
lines to the circle (Figure 4B-2F), and use the Trim tool to trim off all extended
segments (Figure 4B-2G), and delete the circle with the Delete key on the keyboard
(Figure 4B-2H); this method of preventing “open loop” problem will be called the
“Circle-Extend-Trim” method in later Modules; next, click the Return button to exit the
Surface 1 Profile sketch. Repeat the same procedures to create the sketch for the second
lateral surface (Figure 4B-2I), and rename it “Surface 2 Profile” in the Model panel.
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Figure 4B-2H: The
completed sketch.

Figure 4B-2G: Trimming
off all extended edge line
segments.

Figure 4B-2F: Extending
all edge lines to the circle.

Figure 4B-2I: The “Surface 2 Profile” sketch
for the second lateral surface.

Next, create the first and second lateral surface panels. First, click-select the Style
tool from the Sheet Metal panel to set the thickness parameter for the sheet metal part;
the Sheet Metal Style dialog window opens; accept the default Thickness value of 0.120
in and click the Done button to close the window (Figure 4B-3A). Next, use the Face tool
with the two sketch outlines as Profiles to create the first and then the second lateral
surface panels (Figure 4B-3B). Rename the Face features “Surface 1” and “Surface 2” in
the Model panel. next, use the Rotate tool to rotate the 3D model to the position as
shown in Figure 4B-3C. Use the Zoom Window tool to zoom in the top corner of the
intersecting edge between the two lateral panels (Figure 4B-3D); it is obvious that

Inventor automatically creates a Bend feature between the two lateral panels at their
intersecting edge.
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Step 2: Creating the 3" Face feature from a projected sketch profiles with
modifications for an opening or gap in the sheet metal part

Use the Rotate tool to rotate the model again to a position where the remaining
third lateral surface of the Derived Part can be viewed conveniently (Figure 4B-3E);
click-select this surface and click the Sketch button for a new sketch (Figure 4B-3F);
rename the new sketch “Surface 3 Profile” in the Model panel.
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To create flat pattern out of sheet metal parts in Inventor, a gap between the first
and the last lateral panels is needed; therefore, some modifications to the projected profile
need to be done. In the Surface 3 Profile sketch, use the Project Geometry tool to
project the edge line between the first and the last lateral surfaces (Figure 4B-3G); use
the Offset tool to offset this projected line, and use the General Dimension tool to apply
a 0.001 gap dimension between the projected and the offset lines (Figure 4B-3H); use the
Zoom Window tool to zoom in the corner and use the Delete key on the keyboard to
delete the original projected edge line as shown in Figure 4B-3l; next, with the help of
the Zoom Window tool (Figure 4B-3K), project the remaining edge lines onto the sketch
and change the Style of these projected lines from Reference to Normal; next, repeat the
“Circle-Extend-Trim” method or procedures of drawing a large circle, extending
projected lines to the circle (Figure 4B-3L) and trimming (Figure 4B-3M), and finally
deleting the circle with the Delete key on the keyboard, so as to prevent “open loop”
problem and to complete the profile as a closed loop (Figure 4B-3N).

Figure 4B-3G: Projecting  Figure 4B-3H: Offsetting a Figure 4B-3I: Zooming
the edge between the first ~ parallel line and apply a in and delete the origin-
and third surfaces. 0.001 dimension. nal projected edge line.
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Next, use the Face tool to complete the basic sheet metal part enclosing the 3D
space of a triangle-base right pyramid (Figure 4B-30), and rename the new Face feature
“Surface 3” in the Model panel. Use the Rotate and Zoom Window tools to view how
Inventor creates the corner relief at the corner of intersection among the three lateral
panels (Figure 4B-3P).
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Occasionally, when adding a new Face feature, Inventor will open the Create
Sheet Metal Face dialog window with a “No matching faces found” error message
(Figure 4B-3Q); this is because there is ambiguity on which matching congruent face to
choose for adding a Bend; if this occurs, then click the Edges button in the Face dialog
window, and click-select the appropriate edge (Figure 4B-3R); the green outlined Bend

© Edward Locke 2007 (edwardnlocke@yahoo.com)
FOR EDUCATIONAL USE ONLY. ALL RIGHTS RESERVED.



Inventor (5) Module 4B: 4B- 9

Creating Sheet Metal Parts Enclosing The 3D Space of Right And Oblique Pyramids With The Work Surface of Derived Parts

feature geometry indicator will appear (Figure 4B-3S); click the OK button to create the
Face feature. If the intended design is geometrically possible, then the Face feature will
be created; otherwise, space for corner relief needs to be increased, by one of the two
following methods:

1. Changing the sketch profile. Select the profile sketch in the Model panel;
right-click for the shortcut menu and choose the Edit Sketch option; in the
profile sketch that opens, click-select, hold and drag the short edge line
downward to increase space for corner relief (Figure 4B-4A), or use the
General Dimension tool to apply a larger dimension for the gap; next, click
the Return button to exit the sketch. Next, try using the Face tool to create
the needed face (Figure 4B-4B); once the needed space for corner relief is
provided, the Face with Bend feature can be created,

2. Modifying the Derived Part. Click- Select the Derived Part feature in the
Model panel; right-click for the shortcut menu and choose the “Open Base
Component” option to open the file that originates the Derived Part (Figure
4B-4C); go to the Windows—>Arrange All menu to arrange both the Derived
Part-originating file and the sheet metal file within the same screen (Figure
4B-4D); switch between the sheet metal part file and the Derived Part-
originating file by clicking respective screen area; edit the features in the
Derived Part-originating file first; then, switch to the sheet metal part file and
click the Update button on the Command Bar to update the placed Derived
Part’s 3D model in the sheet metal file, and edit the related features in the
sheet metal part file accordingly.

. . . Figure 4B-4B: Creating the
Figure 4B-4A: Editing the profile sketch. Face feature with Bend once

enough corner relief is
provided.
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Figure 4B-4D: The Derived Part-originating file (top) and
the sheet metal file (bottom) within the same screen.

Step 3: Adding a seam Flange feature connecting the first and the last Face panels

Next, add a seam to the lateral edge of the first lateral Face panel so that it will
overlay the lateral edge area of the third lateral Face panel. First go to the
Tools->Document Settings menu to open the Document Settings dialog window, and
select the highest accuracy parameter (0.11245) in the pull-down menu under Angular
Dim Display Precision heading in the Modeling Dimension Display section (Figure
4B-5A); click the OK button to close the dialog window; then go to the Tools pull-down
menu and select the Measure Angle tool, click-select first and third lateral Face panel to
measure the dihedral angle; it reads 67.3803 deg in the Angle window (Figure 4B-5B).

© Edward Locke 2007 (edwardnlocke@yahoo.com)
FOR EDUCATIONAL USE ONLY. ALL RIGHTS RESERVED.



Inventor (5) Module 4B: 4B-11

Creating Sheet Metal Parts Enclosing The 3D Space of Right And Oblique Pyramids With The Work Surface of Derived Parts

Tut-Right Triangular-Base Pyramid Sheet Metal.ipt Document Setti . [E3

Units |5ketch| Modelmgl

" B7.38014 deg
Length Time
Ilnch j Isecund j
Angle Mass
Idagrea j I\bmass ﬂ

r— Modeling Dimenzion Digpla

Linear Dim Display Precision

% Display as valus

Angular Dim Display Precision 1 Display a name

012345 'I " Display as expression

4

Figure 4B-5B: Measuring the dihedral
angle.

@I 0K I Cancel I Apply I

Figure 4B-5A: The Document
Settings dialog window.

Flange Shape | Unfoid Options | Bend Rekief Options |

Shape - Bend
Bend Radus

Ed” BendRadus  »
istance Fip Dffset]
|
Angle [Fiip Direction]
e 3] ]

)| 0K Concel | «|

Figure 4B-5C:
Selecting the inner
lateral edge of the first
lateral panel.

Next, select the Flange tool from the Sheet Metal panel, use the Zoom Window
tool to zoom in the corner of intersection among the three lateral panels; click-select the
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inside lateral edge of the third lateral panel (it turns blue); type 180-67.3803 (degrees) in
the Angle text field (in this case, the bending angle = 180° — dihedral angle); accept the 1
in default value for Distance; click the >> button at the lower-right corner of the dialog
window to open the Extents section; select Offset in the pull-down menu under the Type
heading; type 1 (inch) in both Offsetl and Offset2 text field; click any one of the two
arrow button on the left of the text field and move the mouse cursor closer to one
endpoint of the blue selected edge line and click once at the appearance of the outlined
yellow circle snap indicator (Figure 4B-5C); move the cursor closer to the other endpoint
of the blue edge line and click once at the appearance of the outlined yellow circle snap
indicator; the green outlines of the flange’s geometry appear (Figure 4B-5D); click the
Flip Offset and then the Flip Direction button in the Flange dialog window to make
sure that the outlined geometry indicator of the new Flange feature is shrinking inward
and pointing towards the third lateral panel (Figure 4B-5D); use the Rotate tool to rotate
the model to a position where the flange’s geometry can be seen inside the third panel
(instead of overlapping it) as shown in Figure 4B-5E; if not, then click the Flip Offset
button to make correction; next, use the Rotate tool to rotate the model to a position
where the flange’s geometry can be viewed in its entire length, to make sure that its end
portion closer to the third lateral panel does not extend beyond the third lateral Face
panel, as shown in Figure 4B-5F, otherwise, increase the Offsetl or Offset2 value
(sometime, increase the Offset value first to avoid overlapping, then apply a large
Corner Chamfer, then edit the Flange feature’s Offset value to bring the Flange feature
closer to the end of the selected edge if needed, as a “work-around” method); click the
OK button to create the Flange feature; and rename the new Flange feature Lateral Seam
in the Model panel. Next, select the Corner Chamfer tool to add 0.75 (inch) chamfers to
both ends of the Lateral Seam Flange feature (Figure 4B-5G).
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Step 4: Adding a Flange features connecting the sheet metal part with a level ground

Next, create three flanges at the base edges to allow the sheet metal part to be
attached to a level ground. First, turn on the Visibility of the XZ Plane in the Model
panel, then go to the Tools menu and select the Measure Angle tool to measure the
dihedral angle between the XZ Plane and anyone of the lateral Face panels (since this is
a right pyramid with a equilateral triangular base, all dihedral angles are equal and only
one measurement is needed), the Angle text field reads 106.10101 deg, as shown in
Figure 4B-6A. Next, with the help of the Rotate and Zoom tools for selecting the correct
edges, select the Flange tool with 1 in Distance; type 180-106.10101 deg in the Angle
text field; choose Offset as Type with 1 (inch) for both Offsetl and Offset2 in the
Extents section; click-select the outer base edge, choose an upward Flip Offset direction,
and an outward Flip Direction (Figure 4B-6B); click the Apply button to create the first
base flange without closing the Flange tool’s dialog window; continue to create the
second and third base flange in the same manner, except that in creating the last flange
(the third), clicking the OK button instead of the Apply button, so as to exit the Flange
tool. Rename the new Flange features “Base Flange 1,” “Base Flange 2,”and “Base
Flange 3” in the Model panel. Use the Rotate tool with the Common Views [SPACE]
option selected from the tool’s right-click shortcut menu, rotate the model to the front and
side views, to check if the base flanges appear horizontal (Figure 4B-6D).

Next, use the Corner Chamfers tool to add 0.75 (inch) chamfers to both ends of
all Base Flange 1, 2, and 3 features (Figure 4B-6E).
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Figure 4B-6A: Measuring the
dihedral angle.

Figure 4B-6B: The Flange tool’s dialog window.
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Figure 4B-6E: Adding Corner Chamfers to
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Figure 4B-6F: The top view.

The sheet metal part is completed (Figure 4B-6F). Click-select the outer surface
of the 2™ Face panel (Figure 4B-6G) and then select the Flat Pattern tool to generate the
Flat Pattern view (Figure 4B-6H). The features of the sheet metal part are listed in the
Model panel (Figure 4B-61).
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Section 2:
Creating A Sheet Metal Part Enclosing The 3D Space of A Truncated

Right-Axis Triangle-Based Pyramid

In this part of the Module 4B, we will learn how to create an Inventor sheet metal
part enclosing the 3D space of a truncated right pyramid with a cover for the truncated
top surface; and we will use the techniques explored in the previous part of the Module
4B, and explore some “work-around” techniques on using the Work Plane tool in the
solution of sheet metal design problems with Inventor that involves a cover for an
inclined surface as well as problems of “self-intersecting” surface panels. We will use the
previously created Tut-Truncated Right Triangular-Base Pyramid.ipt file as a Derived
Part to create a sheet metal part. The step-by-step procedures are explained as follows.

Step 1: Creating the three lateral Face panels
Launch Inventor, start a new Sheet Metal (in).ipt file under the English tab.

Click the Return button to dismiss the default sketch; select the default Sketchl feature
in the Model panel and delete it with the Delete key on the keyboard. Go to the
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View-> Isometric menu for better visualization in 3D space. Next, use the same
techniques as explored in the previous part of the Module 4B to place the 3D model of
the Tut-Truncated Right Triangular-Base Pyramid.ipt file as a Work Surface, and create
all lateral Face panels, lateral and base seam Flange features with Corner Chamfers,
with the same parameter setups as in the previous part (Figure 4B-7A). Select the outer
surface of the 2" Face panel and then select the Flat Pattern tool to create a Flat
Pattern view (Figure 4B-7A). Save the file as Tut-Truncated Right Triangular-Base
Pyramid Sheet Metal.ipt in the same Tut-Pyramid folder. Save often throughout the entire
project.

(D Flat Pattem l Figure 4B-7A: The
Flat Pattern completed lateral Face

panels of the sheet
metal part enclosing the
3D space of a truncated
right pyramid.

Isometric view (left).
Flat Pattern view

(right).

Step 2: Creating the top Flange features from two lateral Face panels to connect and
support the top Face panel

Next, create the two top Flange features from the two lateral Face panels on the
left and right hand sides, so as to connect and support the top Face panel to be created.
First, go to the Tools menu and choose the Measure Angle tool to measure the dihedral
angle between the top Work Surface of the placed Derived Part and one of the lateral
panels on the side (in this case, the right one, as shown in Figure 4B-8A). Next, click-
select the Flange tool; in the Extents section, choose Offset as Type (the other option is
Width. Edge option can not be used in this case because of potential problem of self-
intersecting), and type 1 (inch) in both Offsetl and Offset2 text fields; click-select the
respective arrow buttons in the dialog window, and the inner edge of the lateral panel (it
turns blue) and the two endpoints with the help of outlined yellow circle indicator (Figure
4B-8B), before clicking the Apply button, using the Rotate and Zoom tools to rotate the
model to needed positions and to enlarge the view, so as to ensure that the direction of the
flange (Figure 4B-8C) and its position relative to the ends of the lateral panel are correct,
and that there is no problem of self-intersecting, and that appropriate space for the flange
on the opposite lateral panel exists (Figure 4B-8D); after a visual check-up, it is obvious
that a distance between the end of the flange and the corner of the lateral panels opposite
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the one that connects the top panel needs to be increased; therefore, increase it to 3
(inches) in the Flange tool’s dialog window and; additional visual checkup indicates that
it will work; therefore, click the OK button to complete the first top flange; and rename
the new Flange feature “Top Flange 1” in the Model panel. Next, use the Rotate tool to
rotate the model to the bottom view so that the first top flange can be clearly seen, and
add a 0.75-inch Conner Chamfer to both ends of the Top Flange 1 (Figure 4B-8E);
rename the new Corner Chamfer features as “Top Flange 1 Chamfers.” Repeat the same
steps to create the top flange with chamfers from the other lateral Face panel and
complete the sheet metal part (Figure 4B-8F); rename the new features “Top Flange 2”
and “Top Flange 2 Chamfers.”

Flange : Top Flange 1
Flange Shape:| Unfold Options | Bend Resef Options |

- Shape Bend
Bend Radius
Distance
[rin v] ﬂl F 3

Angle

|1E]deg-‘ll&? vl

[11871051 deg

2 e TR R

b
Extents

Figure 4B-8A: Measuring the
dihedral angle.

Figure 4B-8B: Selecting the inner edge and the Offsetl
and Offset2 endpoints.
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Figure 4B-8C: Rotating and zooming to a
needed position area. :
Figure 4B-8D: Checking for problem of
self-intersecting.

Comner Chamfer : Top Flange 1 Chamfers [E3|

Figure 4B-8E: Rotating the model to a
bottom view position, and adding Corner Figure 4B-8F: The completed part so far.
Chamfers.

Step 3: Creating the cover for the truncated top surface

Next, start creating the cover for the truncated top surface. Click-select the Work
Plane tool and then click-select the truncated top surface of the Derived Part, hold the
mouse button and drag out a new Work Plane, an Offset text field appears; type 0.001 in
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for distance (the tiny distance to separate the top Face panel to be created, from the
existing lateral Face panels, and to allow Inventor to create the Flat Pattern view); next,
click the green check mark to finish (Figure 4B-9A). Rename the new Work Plane
feature “Truncated Top Work Plane” in the Model panel.

Next, select the Truncated Top Work Plane and click the Sketch button to start a
new sketch; rename the new Sketch feature “Truncated Top Surface Profile” in the
Model panel; click the Look At tool icon in the Command Bar and then the “Truncated
Top Surface Profile” Sketch feature in the Model panel to switch to an orthographic
view, and use the Zoom Window tool to zoom in closer to the area of the truncated top
surface, which is in the shape of an isosceles triangle (Figure 4B-9B); zoom window
again the top corner of the “isosceles triangle;” use the Project Geometry tool to project
the two inclined inner edges of the lateral Face panels onto the Truncated Top Surface
Profile sketch; change the projected lines” Style from Reference to Normal in the
Command Bar; next, use the “Circle-Extend-Trim” method to prevent potential problem
of “open loop”, using the Circle Center Point tool to draw a construction circle, the
Extend tool to extend the edge lines to the circle (Figure 4B-9C); the Delete key on the
keyboard to delete the circle and the Trim tool to trim off the excessive line segments
(Figure 4B-9D); next, use Zoom All and then Zoom Window tools to access an enlarged
view of the lower left corner. The horizontal edge at the bottom of the triangle in this
view is the edge of the top Face panel to be created, which connects the edge of the
middle lateral Face panel; due to the way the Bend of the Face feature connects the two
Face panels, there can be problems of self-intersecting when the flat pattern is generated,
as shown in Figure 4B-9E. To avoid this potential problem, add bend relief as explained
in the next paragraph.

Figure 4B-8A: Creating Figure 4B-9B: The
the “Truncated Top *““isosceles triangle”™
Work Plane.” shape of the top surface.

Figure 4B-9C: Preventing
open loop problem.
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Problem of overlapping or

self-intersecting

Eee /
EEEEEEES /

[ N E /

¥ \\. 1';
Figure 4B-9D: The Truncated Top Surface Panel

top corner. . . .
Figure 4B-9E: Potential problems of over-lapping or

self-intersecting between two panels connected by a
Bend feature.

Use the Project Geometry to project the horizontal outer edge of the lateral
panel, change the projected lines’ Style from Reference to Normal in the Command Bar;
then use the Fix tool to fix this line to position; use the Line tool to draw a horizontal line
above it and a vertical line on the right of the vertical edge between the straight portion of
the lateral panels and the rounded Bend feature; next, selected the General Dimension
tool to apply a 0.2-inch vertical linear dimension between the two horizontal lines (which
allows a gap or relief between the top and lateral Face panels, for cutting the sheet metal
material, when the flat pattern is developed, as shown later in Figure 4B-10C); and then a
0.25-inch horizontal linear dimension between the vertical line and the vertical edge
between the straight portion of the lateral panels and the rounded Bend feature, by
clicking the vertical edge (a projected line from the vertical edge selected by the General
Dimension tool is automatically generated) and the vertical line (Figure 4B-9F); next,
use the Trim tool and the Delete key on the keyboard to delete the dimension, the
projected vertical edge and trim off all excessive line segments (Figure 4B-9G); next,
repeat the same procedures to the right corner of the top surface, and use the Trim tool to
cut off the middle segment of the top horizontal line (Figure 4B-9H) and to leave clean
profiles of the left corner (Figure 4B-81) and right corner (Figure 4B-8J) of the sketch;
next, click the Return button or right-click for a shortcut menu and choose the Finish
Sketch option to exit the Truncated Top Surface Profile sketch (Figure 4B-9K).
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Figure 4B-9G: The initial
sketch. Figure 4B-9H: Trimming
excessive line segment.

Figure 4B-9F: Projecting
and fixing the horizontal
outer edge line.
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Figure 4B-9I: The profile at Figure 4B-9J: The profile at _
the lower-left corner. the lower-right corner. () Create pate

Sketch Doctor

Prewviouz Wiew  +F5

lzometnic isw

How Ta..

Figure 4B-9K:
Finish Sketch.

Next, create the truncated top surface Face panel. Since the profile for the
truncated top surface panel is created on the Truncated Top Work Plane that is not
touching but a short gap of 0.001 inch above the lateral Face panel, Inventor will not
generate a bend between the existing lateral Face panel and the new top panel by default,
unless an edge is selected with the Edges arrow button in the Bend section of the Face
tool’s dialog window; therefore, we have two options: either assigning an edge for the
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Bend feature (in this case, the inner edge of the existing lateral Face panel (Figure 4B-
10B) and creating the top panel with a Bend connecting it to the existing lateral Face
panel all at once; or creating a default separate top surface Face panel (Figure 4B-9A),
and later add a bend with the Bend tool (Figure 4B-9C). in either case, rename the new
Face feature “Top Panel” in the Model panel after it is created.

Face

Face Shape I Unfold Dptlnnsl Bend Relief Dptlonsl
Shaps Bend

Badi
[% Profile s
IEendHadius »
| Dffsat
_I [} | Edges v ‘

Cancel | ¥

Figure 4B-10A: Creating a
separate top panel without the
Bend feature.

;.,,m I“‘”""“‘." el e | Face Shaps |u¢aﬁh:_'|:umml

EM [&‘:}- AMB"‘" %
o] et '. 5t o o By

o e

Figure 4B-10B: Selecting the inner edge of the lateral panel to create a Bend feature
between the existing lateral Face panel and the new top face panel to be created.
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Bend Shape | Uniold Options | Bend Rielef Options |
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— Double Bend
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¥ 45 Deqee & 50 Deqree
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Figure 4B-9C: The Bend tool dialog window (left); selecting the same inner edge
(middle) and creating a separate Bend feature (right).

Figure 4B-9D: The Top Panel (left); the
isometric views of the finished part (right). The

orthographic views (Bottom).

Left Side View

Front View Right Side View
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Next, click-select the Flat Pattern tool from the Sheet Metal panel again to open
the Flat Pattern window opens (Figure 4B-10A); use the Zoom window tool to zoom in
the area where the bend occurs between the top Face panel and the middle lateral Face
panel, the bend relief is shown (Figure 4B-10B); the Flat Pattern is actually a 3D model
by itself and can be rotated to different views with the Rotate tool (Figure 4B-10C); in
addition, it can be viewed in Wireframe Display mode (Figure 4B-10C). The features of
the model are listed in the Model panel (Figure 4B-10E).

Sheet Metal =

th Flat Pattem

Figure 4B-10A: The Flat Pattern.

Figure 4B-10B: The

bend relief. Figure 4B-10C: 3D view
of the Flat Pattern.
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Bend20

L3 End of Part

Figure 4B-10E: The features listed in
the file’s Model panel.

Please notice that, due to several factors such as available sizes of sheet metal
materials, and the convenience and cost of cutting versus bending, it is sometimes
preferred to create separate lateral Face panels with Flange features on the top and base
of all panels as connecting and supporting elements for the separate top and base Face
panels, in one piece (and one sheet metal .ipt file in Inventor), and separate top and base
panels in separate files; and to assemble these separate sheet metal parts through welding,
riveting, bolting and other assembling process. In Inventor, the folded models of separate
sheet metal .ipt files can be assembled in a Standard (in).iam assembly file.

Congratulations! In the Modules 4A and 4B, you have learned important
techniques of

e Creating 3D folded models and 2D Flat Pattern views of regular and
truncated right-axis triangle-based pyramids;
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e Using the Work Surface of a Derived Part for the creation of sheet metal
parts;

e Using Work Plane, Work Point and Work Axis tools creatively for the
solution of mechanical engineering-related descriptive geometry problems.
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